
MorphBar Help Contents
Welcome to MorphBar for Windows 95 and NT

Click for help on:

· The Icon Bar
· The Properties Dialog
· The Control Dialog
· The Text Editor
· The File Manager
· Registration
· Registration Form
· ShareIt! Registration Form
· Credits

Click to find out how to:

· Add a new program to the bar
· Keep the bar visible over applications
· Remove a program from the bar
· Run programs without adding an icon to the bar
· Edit text files using MorphBar
· Set the default options
· Close or minimise MorphBar



The Icon Bar
The Icon Bar is the most important part of MorphBar. It consists of a number of program launch buttons, 
two scroll buttons, a control button and a panel showing the current date and time. 

Launch Buttons

Click the left mouse button on a launch button to run the program it refers to. Click the right mouse button 
on a launch button to edit the properties of the button using the Properties Dialog.

To add a new program to a button using drag and drop simply drag the filename from Explorer to the 
correct launch button position. The properties dialog will then pop up with most fields filled in for you. Note
that you should drag and drop one file at a time (MorphBar only handles the first file of a set if you drag a 
set onto a launch button) and that dragging a file onto an occupied launch button will change the contents
of that button (you can press Cancel in the properties dialog if you made a mistake).

If you hold the mouse pointer over a launch button for a second or so a 'hint' will appear displaying the 
name of the program the button is associated with, unless you have the 'Show Hints' option turned off in 
the Control Dialog.

Left clicking on blank buttons has no effect. Right clicking on blank buttons allows you to enter new 
program details in the Properties Dialog. 

Scroll Buttons

You may have more buttons in the Icon Bar than can be displayed at once - you can see all the additional 
buttons using the scroll buttons.

When MorphBar is first started you will always be located at the top of the available set of buttons and the
'scroll down' button will be greyed out. 

You can always scroll the buttons up and when you have filled the viewable portion of the Icon Bar you 
will have to scroll them up to add more programs.

Morph Button

Clicking on the Morph Button opens the Control Dialog where you can set the MorphBar options, run 
programs from a command line and start the built in text editor and file manager
Date Panel

The Date Panel is a display only indication of the current time and date. Clicking the right mouse button 
on this panel pops up a menu allowing you to close or minimise MorphBar.

The format of the panel display is taken from the Windows defaults which you can set in the Windows 
Control Panel. The actual time and date displayed is that used by your computer. This can be set through 
the Windows Control Panel, from DOS or from your PC system firmware.

You can use the date panel as a 'safe' area to left click on when you wish to make MorphBar the current 
application but don't wish to click on any icons.



The Properties Dialog
The Properties Dialog appears when you click the right mouse button on one of the program launch icons
or drag and drop a filename from the Windows Program Manager onto a launch icon.

It allows you to enter, alter and delete the following information for each launch button:

Program Name

Enter the program name (maximum length 25 characters). 

MorphBar uses the name entered here when it displays the hint associated with each icon. You can 
disable the hints by clearing the 'show hints' checkbox in the Control Dialog.

Command

Enter the command line associated with the button being edited.

If you click the button you can locate the program using a standard Windows file dialog. 

If the program you want to run requires parameters to be passed to it when it is started, you can either 
enter them in the Arguments text box (for permanent parameters) or click the 'Ask For Parameters' check 
box to have MorphBar pop up a parameters dialog when you launch the program.

Working Directory

Enter the working directory for the program you are setting up.

If you leave this field blank MorphBar will use the pathname from the Command Line field as the working 
directory. 

Icon File

Enter the full filename of the icon to be displayed in the Icon Bar.

If you click the button you can locate the icon file using the standard Windows file dialog. 

You can enter either the name of a single icon file (.ICO) or the name of a file containing multiple icons 
(.EXE or .DLL).

If you leave this field blank, MorphBar assumes there is an icon in the filename in the Command Line field
and uses it. 

If the filename in the Command Line field is a document file MorphBar will try to find the associated icon.

If the Command Line file has no icons (it's a DOS program, for example) or association you will have to 
enter an alternative filename here. If all else fails use one of the icons in MORICONS.DLL in the Windows
directory.

If your icon file or executable file contains multiple icons you can step through them using the Previous 
and Next icon buttons. You will not be to do this for a document file using file association.

By default MorphBar always reads icons from the file you specify in the Icon File edit box. If this file is not 
always available (it may be on a network drive or removable media) MorphBar can store a copy of the 



selected icon in the directory pointed to by the 'icon directory' entry in the Control Dialog. To use 
MorphBar's stored icon for a particular button check the 'Use MorphBar Copy of Icon' checkbox.



The Control Dialog
The Control Dialog appears when you click on the Morph Button on the Icon Bar. It is divided into two.

Default Configuration

The top half of the dialog allows you to configure the position and style of the Icon Bar.

The startup position of the Icon Bar is set by clicking either the Bar On Left or Bar on Right radio buttons.

If you click the Keep On Top checkbox MorphBar will remain visible over other applications.

If you click the Show Hints checkbox MorphBar will display the program Name (set in the Properties 
Dialog) as a hint when the cursor rests over an button.

The Icon Directory text box displays the current location for MorphBar's icon files (MICON*.ICO). When 
MorphBar is first installed this defaults to the Windows root directory. You may prefer to keep your 
MorphBar icons in an alternative directory and to do so simply alter the directory name. MorphBar will 
advise you to move any existing MICON files to the new directory immediately as it will look in the new 
directory for icon files when you use the scroll buttons.

If you are unregistered you will also see a text box for entering your registration ID.

Note that all changes made to the default configuration apply straight away but only become permanent 
when MorphBar is shut down.

Utilities

You can launch the built in text editor by clicking on the button marked 'Editor'

You can launch the built in file manager by clicking on the button marked 'File Manager''.

The bottom half of the dialog enables you to run programs without configuring a new launch button.

To run a program simply type the full pathname of the program in the edit box provided and click the 
button marked 'Run'. If the program requires parameters to be passed to it you should check the 
checkbox before running the application. You can also enter any data file name that has a file extension 
associated with an available application.

MorphBar remembers the last ten programs that you ran and keeps the commands available in a list box 
which you can view by clicking the drop down arrow at the right of the edit box.

You can select a program to run by using the Browse button, which displays a standard Windows file 
dialog.



The Text Editor
MorphBar's built in text editor is suitable for editing small files. It can read and write files in Rich Text 
Format or plain ascii. You can switch it into plain ascii mode by checking the 'plain ascii' option in the 
options menu.

If you have an e-mail system the editor can be used to edit messages. You send an edited message by 
using the Send... option on the File menu.

It supports search, search and replace, cut, copy and paste operations. Cut, copy and paste are 
implemented via the Windows clipboard so you can import text from, and export text to, other 
applications.

If you make any modifications to a file that you have previously opened you will be prompted to save it 
when you exit the editor.



The File Manager
Morphbar's built in file manager displays files in a similar manner to the Windows Explorer. 

You can change the displayed drive by clicking on the drive tabs at the bottom of the window.

You can copy, move, rename or delete a file by highlighting it in the right hand pane of the window and 
then selecting the required function from the File menu. You can also copy files by dragging and dropping 
them within the file manager.

You can alter the display of filenames by deselecting options in the options menu.

You can see the file attributes by selecting prpoerties in the file menu.



Registration
MorphBar is Shareware. This is a form of software distribution that allows you to try out commercial 
quality software in your own environment and in your own time. This 'evaluation period' is limited to 30 
days.

Shareware is not free. If you are still using MorphBar after the evaluation period is complete then you 
need to pay for it. MorphBar costs $40. 

You may have paid a small distribution fee to a third party (bulletin board operator or shareware vendor) 
but none of this money will reach the author.

Paying for MorphBar will gain you the following benefits:

· You get a registration code which identifies the software as registered to you on the opening splash 
screen - and makes it automatically disappear as soon as MorphBar is initialised.

· You get free lifetime software support for your version of MorphBar. This may include free upgrades 
for major bug fixes.

· You get low cost upgrade offers to subsequent versions of MorphBar.

· You're legal.

To register, fill out the Registration Form in this help file.

If you wish to register using a credit card, fill out the ShareIt Registration Form



Registration Form
Help

Registration Form
Product Name: MorphBar for Windows

Version No: 1.4

MorphBar costs $40. This includes all postage and additional charges where 
applicable. The following rates apply for multiple purchases:

           Up to 10 ___ copies @ $40 each = ____
           11 to 50 ___ copies @ $24 each = ____
           51 +     ___ copies @ $16 each = ____

Unlimited licence: Please contact the author for pricing!

Disks (available only with registration or to registered users):

                1 disk of MorphBar @  $32 = ____

Total Cost:                                  = ____

Please pay by Cheque drawn on UK bank or International Money Order in UK 
Pounds Sterling or equivalent. To pay by credit card please see the ShareIt 
Registration Form.

Cash can be sent in your own currency (notes only - convert upwards to nearest
match) or UK Pounds Sterling, but strictly at your own risk.

I would like to pay by: 
Cheque / International Money Order / Cash

  Please find enclosed £___________

Terms/Conditions:
I agree MorphBar is distributed as shareware.  No warranty exists, either 
express or implied.  No liability is assumed for any damage or loss resulting 
from the use of this program. No claims are made regarding the accuracy of 
this program. The author reserves the right to change pricing in future 
versions.

I agree that MorphBar, if being used on more than one computer must have a 
licence for each computer. 

A letter will be sent to you providing you with your serial number and user 
name.

We can also FAX you or E-Mail you on the Internet.

Your signature below indicates your acceptance of these terms and conditions.

Signed: __________________________________________  



Date: ______________

User Name:_____________________________________
(Name you would like to have as your User Name)

Contact Name: _____________________________________
(Only if different from the User Name)

Gender: M/F  

Occupation:_____________________________________

Title:__________________________________________

Company:________________________________________

Postal Address:___________________________________________________

    ______________________________________________________________

City:___________________________________________

COUNTRY:__________________________________________

Phone No: ______________

Fax No:   ______________

Type and Speed of 
computer:____________________________

Type of display used:________________________

Internet 
address:____________________________

Preferred method of receiving Serial Number: 
Fax / Internet /Snail Mail

Preferred method of getting updates: Internet / Snail Mail

Disk Size: 3.5"/5.25"

What would you like to see improved or added in MorphBar (optional):

Where did you find out about MorphBar (optional):

Make Cheques Payable to 'Mr J. R. Cope' and mail along with form to:



Mr J. R. Cope
17 Highland View
Bransty
Whitehaven
Cumbria
CA28 6HF
Great Britain                           

Thank you for your registration!!

Roger Cope



ShareIt! Registration Form
MorphBar/32 Registration

Registration fee: $40

If you would like to register MorphBar/32, you can do the registration online on the Internet at 
http://www.shareit.com/programs/100253.htm.

Alternatively, you can go to http://www.shareit.com and enter the program number there: 100253. 

If you do not have access to the Internet, you can register via phone, fax or postal mail. Please print out 
the following form, and fax or mail it to:

Reimold&Schumann Internet Services
ShareIt!
Jahnstrasse 24
50676 Koeln
Germany

 Phone:                 +49-221-2407279 
                                                                +49-172-7229837
Fax:                                         +49-221-2407278
E-Mail:                                            register@shareit.com

Registration form for MorphBar/32

Program No.: 100253

Last name: ______________________________________

First name: ______________________________________

Street and #: ______________________________________

City, State, postal code: ______________________________________

Country: ______________________________________

Phone: ______________________________________

Fax: ______________________________________

E-Mail: ______________________________________

How would like to receive the registration key/full version?

e-mail - fax - postal mail

How would you like to pay the registration fee of $40:



credit card - wire transfer - EuroCheque - cash

Credit card information (if applicable)

Credit card: Visa - Eurocard/Mastercard - American Express - Diners Club

Card holder: ___________________________________

Card No.: ___________________________________

Date of Expiration : ___________________________________

Date / Signature ___________________________________



To print this registration form, choose 'Print Topic' from the File menu in the Help system.

Alternatively, choose 'Copy' from the Edit menu in the Help system and select all the text below. Paste it 
into the MorphBar text editor and print from there.



Credits
MorphBar was written by Roger Cope (see Registration for contact info).

The primary development tool was Delphi 2.0 by Borland.

MorphBar is also available in a 16 bit version produced using Delphi 1.0.

The utility had a previous life as MorphBar/VB, written in Microsoft's Visual Basic 3.0 as a bit of fun. The 
functionality of the two is much the same but Delphi gives the utility a useful turn of speed, a slightly more 
modern look and feel and a proper (lean and mean!) executable. I prefer Delphi but happily use both.

More Credits:

Development Platform - Wearnes 486/80
- Mitac Pursuit 686/120+

Development environment (part 1) - Windows for Workgroups 3.11 layered on MS-DOS 6.21 running 
4DOS 5.5 as the primary shell.

Development environment (part 2) - Windows 95.

Entertainment by Jupiter Software's CDPlayer 3.4d.



Adding A New Program
To add a new program to the Icon Bar click the right mouse button on a blank button. This will display the
Properties Dialog where you enter the details of the program to be included on the bar.

Click the OK button to add the new program to the bar or the Cancel button to exit the dialog without 
creating a new button.

To add a new program to a button using drag and drop simply drag the filename from Explorer to the 
correct launch button position. The properties dialog will then pop up with most fields filled in for you. Note
that you should drag and drop one file at a time (MorphBar only handles the first file of a set if you drag a 
set onto a button) and that dragging a file onto an occupied button will change the contents of that button 
(you can press Cancel in the properties dialog if you made a mistake).

If there are no blank buttons on the Icon Bar you will have to scroll the buttons up until a blank button 
appears using the scroll buttons. Alternatively, you can alter the details behind an existing button that you 
no longer want on the bar.



Keeping MorphBar Visible
You may find it useful to keep MorphBar visible all the time. You can prevent it being obscured by other 
windows by checking the 'Keep On Top' checkbox in the Control Dialog.

You display the Control Dialog by clicking the Morph button on the Icon Bar.



Removing A Program
You remove a program from the Icon Bar by clicking the right mouse button on the button concerned. 
This displays the Properties Dialog. Click the Clear All button to remove the property information from the 
dialog and then click the OK button.

You can click the Cancel button to return to the Icon Bar without deleting the program information.

You can delete an button in any position on the bar but MorphBar does not reshuffle the remaining 
buttons to close the gap.



Running Programs Without Icons
You do not have to create a button and it's associated program information in order to run a program 
using MorphBar.

You may only need to run a program occasionally, or for test purposes, and in these cases setting up a 
launch button is a lot of trouble.

If you click on the Morph button you will display the Control Dialog. You can run a program from this 
dialog by entering the full pathname in the edit box at the bottom of the dialog and clicking the Run button.
You can use the Browse button to locate the program file using a standard windows file dialog.

MorphBar keeps a list of the ten most recent programs run from the Control Dialog and you can display 
this list by clicking the drop down arrow at the right of the edit box.

You can also launch an application by opening the file manager and double clicking on the chosen 
filename in the left hand pane of the window.



Editing Text Using MorphBar
MorphBar incorporates a rich text format text editor. You access this by clicking on the 'Editor' button from
the Control Dialog, which is displayed when you click the Morph button on the Icon Bar.

You load a file using the File menu within the editor.



Setting The Default Options
MorphBar has only a few options. You can have the Icon Bar displayed on the left or right edge of the 
screen, you can have Windows treat the Icon Bar as a normal window or keep it in view all the time and 
you can control the hints display.

All these options are set in the Control Dialog which is displayed when you click the Morph button on the 
Icon Bar.



Closing or Minimising MorphBar
Because MorphBar is a very narrow application it has no control icons at the top of the window. You can 
close or minimise it by clicking the right mouse button on the Date Panel at the bottom of the bar and 
choosing the desired option.

Note that MorphBar will close just fine on it's own when you shut Windows down.






